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Preface 

PROSE is a text-editing application package for the Professional series computers 
that enables you to easily prepare memos, reports, programs, and other kinds 
of text. With PROSE, you can create, edit, move, replace, and format text 
using the PROSE menus and function keys on your Professional keyboard. 

WHO SHOULD READ THIS BOOK 

This manual provides tutorial instruction for beginners, and can be used as a 
reference for more advanced users. 

INFORMATION IN THIS BOOK 

This manual is divided into two chapters: 

Chapter 1: Getting Started with PROSE-all you need to know to get an editing 
job done. 

Chapter 2: Advanced PROSE-additional functions that make editing easier and 
allow you to change your text format. 



CONVENTIONS USED IN THIS BOOK 

The descriptions of procedures and commands in this book use certain conventions 
to represent how an action is performed, or how a command is entered from 
the keyboard. These symbols are: ~ 

CTRL/ 

RETURN 

Press 

Type 

Choose 

<> 

Red type 

Italics 

Dot Matrix 

iv 

Indicates that you hold down the CTRL key while 
you press a second key. For example, CTRL/Z 
means hold down the CTRL key and type Z. 

This typeface denotes a key on your Professional 
keyboard, for example, the RETURN key. 

Tells you to make one keystroke with the key 
indicated. 

Directs you to enter characters from the main 
keyboard. For example, if you are asked to type 
RETURN, you make six keystrokes; one for each 
letter. 

Directs you to single out an item from a list of 
menu options (with an ARROW key or the cursor), 
and then press the DO key to initiate the action. 

Angle brackets that appear in examples indicate 
that you press a function key. For instance, 
<RETURN> tells you to press the RETURN key, 
and <CTRLIW> tells you to hold down the CTRL 
key and type W. 

Indicates segments that you enter from the 
keyboard. 

Words defined in the glossary appear in italics the 
first time they are used in the book. 

Indicates text that appears on your screen. 

) 
----



RELATED DOCUMENTS 

Hard Disk System User's Guide is the P/OS operating system user's guide. This 
manual provides instructions for installing and using P/OS and logging into a 
user account. It also provides the instructions for installing PROSE on your 
Professional. 

Hard Disk System.f"or Beginners is your first book if you are new to the Professional, 
or new to computers. Read and go through its exercises before attempting to 
use or even install PROSE. It covers the elementary steps for using the Profes­
sional, and it uses PROSE for its main exercise session. 

Professional PRO/EDT User's Guide describes PRO/EDT, another text editing 
application included with your Professional. PROSE and EDT use different 
approaches to editing, and each has advantages in specific situations. You should 
evaluate both packages before choosing which one to use for preparing text. 
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Chapter 1 

Getting Started with PROSE 

Whether you are creating a simple memo or a complex document, the editing 
functions offered by PROSE are efficient and easy to use. 

This first chapter is for you if you are new to PROSE. If you are also new to 
P/OS, you should first read Hard Disk System for Beginners. If PROSE is 
already installed on your system, and you already have some experience using 
it, you may want to skim this chapter and go on to Chapter 2, Advanced 
Features. 

INSTALLING PROSE 

PROSE is a software application that must be installed on your Professional 
before it can be used. If it has not been installed, see the instructions for installing 
applications in your Hard Disk System User's Guide and install PROSE before 
proceeding with this book. 

GETTING HELP 

By pressing the HELP key, you can get a great deal of online information about 
the PROSE functions. If you would like a general explanation of a menu, for 
instance, just display the menu and press HELP. If you would like more information 
about a particular menu item, place the pointer to the item and press HELP. 
It's a very efficient way to learn PROSE. 

3 



CHAPTER 1 I PROSE USER'S GUIDE 

THE PROSE MENU 

Choose PROSE from the P/OS Main Menu (or from one of the additional applications 
groups if it is installed there). The PROSE Menu will appear. 

Figure 1-1 
PROSE Menu 

If you want to create new text, choose "Create new file." If you want to alter 
an existing text file, choose "Edit existing file." 

4 
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GETTING STARTED I CHAPTER 1 

Creating a New File 

When you choose "Create new file" from the PROSE Menu, the screen looks 
like this: 

No~o~ doin9: [Jvert~pe tlarg,ns: lO, 5::• Wcrd l.'rapp'?·J 
,------·-----, r-- Edtt - --~ r- Pr:-..-s:,oa. ize -------- F(J!i);t -----, 

Figure 1-2 
Editing Menu 
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CHAPTER 1 I PROSE USER'S GUIDE 

The blank space is for you to type in your text. For example, 

Figure 1-3 
Editing Menu with Sample Text 

When you create a file, the left margin is at the first character column on the 
screen, and the right margin is set at column 72. These are the default margins: 
You have them unless you explicitly change them using the "Margin change/ 
word wrap" additional option. (See "Margin Change/Word Wrap" in this manual 
for an explanation of how to change margins.) 

To allow for the way PROSE fills text when you make changes, you should type 
in two spaces after the end of each sentence. Separate paragraphs with a blank 
line. When you press RETURN, PROSE moves the cursor to the beginning of 
the left margin of the next line. Press RETURN twice to begin a new paragraph. 

In PROSE, the TAB key jumps the cursor by eight-character intervals starting 
at column 9. For instance, pressing the TAB key while the cursor is within 
columns 1--8 moves the cursor to column 9. PROSE also considers the left margin ) 
a tab stop. To change your PROSE tab stops, see "PROSE Additional Options 
Personalize Menu" in Chapter 2 of this manual. 

6 



GETTING STARTED I CHAPTER 1 

NOTE: Tab settings you may have made on the P/OS Terminal Set-up Menu 
do not affect the TAB key when you are in PROSE (see the Hard Disk 
System User's Guide). 

Any time you make an error or attempt to do something that isn't possible, 
PROSE displays a message on the bottom line of your screen. Press RESUME 
to continue after a message appears, or press HELP for more information. 

The status line at the bottom of the screen will not appear in your text (when 
it is printed or copied). This line contains the following information: 

Now doin!l": 

Mar!l"ins: 

WraPPed/Not 
wraPPed 

Edit an Existing File 

Tells you what you are doing at the moment. If 
you are entering text, the word "Overtype" 
appears, to show that you are in Overtype Mode. 
You are in Overtype Mode unless you press 
INSERT HERE or select other functions such as 
finding a word or inserting text. If you select such 
a function, the function's name appears in place of 
"Overtype." 

Tells you the locations of the left and right 
margins, respectively, of the paragraph in which 
the cursor is currently located. In the example 
above, the left margin is at column 1 and the right 
margin is at column 72. 

Tells you whether word wrap is active for the 
paragraph the cursor is in. You need to know this 
because certain PROSE functions are affected by 
the word wrap setting. 

If you choose "Edit an existing file" from the PROSE Menu, a list of the files 
in your current volume and directory appears. If the file is in this directory, 
place the pointer at the file you want to edit and press DO. 

Choosing a File from Another Directory 

If the file you want to edit does not appear, it may be in another directory. To 
select a file from a different directory, press ADDTNL OPTIONS. Select the 
option "Choose a different directory/volume" and press DO. When the Directory 
Selection Menu appears, select the directory you want and press DO. When the 
File Selection Menu appears, select the file you want to edit and press DO. 

7 



CHAPTER 1 I PROSE USER'S GUIDE 

When the file is displayed on your screen, 1 you can add text, change text, and 
so on. 

Moving the Cursor 

The cursor marks the spot where the next character you type will appear. To 
change existing text, you must first move the cursor to the text. 

You move the cursor around in your text with the arrow keys. Each time you 
press an ARROW key, the cursor moves one character or one line in the direction 
of the arrow. Holding down an ARROW key causes the cursor to move continuously 
in the direction of the arrow. 

To move the cursor through more than one screen of text, press PREV SCREEN 
to move backward or NEXT SCREEN to move forward. If there is not enough 
text to allow this, the cursor will move to either the beginning or the end of 
the file. 

You can move the cursor anywhere on the screen. ·You cannot insert text on 
the status line or beyond your right margin in a word-wrapped paragraph. (See 
"Margin change/word wrap" later in this manual.) 

Deleting Characters 

If you make typing errors while entering your text, you can use the delete 
key, (labeled QJ) to erase them. The character to the left of the cursor will 
be deleted each time you press this key. You can hold the key down to delete 
a series of characters. The delete key works like a space bar-in the reverse 
direction. 

The following is an example of using the delete key: 

1. . Before delete: 
I want to delete soMe characters I Just 
tiPed rang,/ 

2. Press QJ 12 times. 

Mter delete: 
I want to delete soMe characters I Jus 

1 You may see some blinking characters in the text display. These represent control characters. Refer to manuals 
that describe the system or application that created the file for more information about control characters. You 
can enter any control character using PROSE. 

8 
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Typing Over Existing Text 

In Overtype Mode (the default mode), you can replace text by typing over it. 
You do not have to delete the original text, as the following exercise illustrates: 

1. Move the cursor to the spot where you want to overtype: 

This is some text to lractice insertin~ in 
OvertYPe mode. 

2. Type in the new text. It replaces the existing text: 

This is some text to see what haPPens when 
I type over other text.@ 

You can replace text with blank spaces by overtyping with the space bar. 

Inserting Text with Insert Mode 

When you want to insert new text or spaces into existing text without erasing 
the original text, use the INSERT HERE key. As an exercise, follow these steps: 

1. Move the cursor to the spot where you want to insert the text. For 
example, 

Let's see how I #an insert new text into 
existin~ text. 

2. Move the cursor to the beginning of the word "can" and press 
INSERT HERE. All text to the right of the cursor moves temporarily 
to the next line, leaving an open space, as follows: 

Let's see how I 
can insert text into existing text. 

3. Type in the text you want to insert, including any spaces you need. 
For example, 

Let's see how I liJIIIIIIIIIltiiiiB.IJII. 
can insert text into existing text. 

Notice that the newly inserted text is in reverse video. (Be sure to 
enter a space after the last word you insert.) 

4. When you finish inserting the new text, press DO. The open space 
closes up, and the inserted text is no longer in reverse video. If the 
paragraph is word-wrapped, the rest of it fills so that there are no 
unnecessary spaces. For example, 
Let's see how I and mY PROSE editor $an 
insert text into existin~ text. 

9 



CHAPTER 1 I PROSE USER'S GUIDE 

When filling existing text, PROSE leaves two spaces after any period, colon, 
exclamation point, or question mark that is followed by a space and then a capital 
letter. 

When you insert text in a paragraph that is not word-wrapped, press RETURN 
after inserting to move the cursor to a new line. In this case, when you press /~ 
DO, the open space created when you pressed INSERT HERE closes up, but ····~ 
the rest of the paragraph remains the same as before. 

In Insert Mode, you cannot use the ARROW, PREV SCREEN, NEXT SCREEN, 
or FIND keys to move the cursor around in your text. You can use the <XI 
key, but only to delete text just inserted in Insert Mode. 

Deleting Text 

To remove portions of text, use the REMOVE key. Follow these steps to delete 
a segment of text: 

1. Using the ARROW, PREV SCREEN, NEXT SCREEN, or FIND keys, 
move the cursor to one end of the segment to be deleted-it does not 
matter which end. For example, enter the following: 
This is sowe text to delete. lhis is sowe 
wore text• but I do not want to delete 
this. 

2. Press REMOVE. 

Using the ARROW, PREV SCREEN, or NEXT SCREEN keys, move 
the cursor to the other end of the segment to be deleted. The 
segment can be any length. For example, 

This is SOMe 
wore text, but I do not want to delete 
this. 

The segment becomes highlighted in reverse video as you move the 
cursor. (Press CANCEL to undo the selection.) 

4. Press DO. The selected text disappears. For example, you might be 
left with: 
lhis is sowe wore text. but I do not want 
to delete this. 

If the paragraph is word-wrapped, the open spaces created by the deletion close 
up after you press DO, and the rest of the paragraph fills. If the paragraph is 
not word wrapped, the open space closes up, but the rest of the paragraph is 
not changed. 

10 
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Exit Menu 

When you want to exit PROSE, just press the EXIT key. The Exit Menu will 
appear: 

Figure 1-4 
PROSE Exit Menu 

Saving Files 

Choose "Save file" to store your text file in the current directory and volume 
(or in another specified directory and volume). When you choose "Save file," the 
following question appears if there are any nondefault word wrap or margin 
settings in the file: 

Saue special word wraP/Mar~in 
settin~s? (YES or NO) 

Type YES and press DO (or just press DO) unless you want to return to only 
the default settings (72-column margins and no word wrap). 

If you type NO and press DO, the nondefault margin and word wrap settings 
you were using will not be in the file the next time you edit it. The file will still 
look the same if you print it or transfer it, but if you try to edit it again, you 
will get unexpected results. 

11 
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The two reasons you might want to remove your special margins and word wrap 
settings would be to use PRO/Communications to transfer the file to a computer 
that does not use PROSE, or to use an application that does not interpret the 
internal settings the same way PROSE does. 

Naming Files 

Mter you answer the word wrap/margin question, a form appears requesting 
a file name: 

Figure 1-5 
Name a File Form 

To name your file, do the following: 

1. Type in the name (a maximum of nine characters) you want to give 
this file. If this is a previously created file, the existing name appears 
on the form. In this case you can either leave it as is, or change it by 
deleting the name and typing in a new name. 2 

2 This is useful for form letters or letterheads. You can create one file as a letterhead. Then, in another editing 
session, add the letter contents for the particular person you are writing to, giving the new file a different 
name. You still have the letterhead for future use. 

12 
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2. Press DO. The file is saved with the name you chose, and the 
PROSE Menu reappears. 

The default file type is "Document." You need to change the file type only if 
you are creating a BASIC program or some other special kind of file. To change 
the file type or directory, press ADDTNL OPTIONS before typing in the file 
name. (See Naming a File-Additional Options below.) 

If you are working on a previously created file, choosing "Save file" creates an 
updated version of your file and saves the previous version. You should delete 
old versions you no longer need in order to free up disk space. You can use the 
"Cleanup" feature from the P/OS File Services Menu to delete all the old versions 
of a file. (See your Hard Disk System User's Guide.) 

Naming a File-Additional Options 

The Name a File Form has some additional options that provide you with more 
flexibility in naming your file. If you press ADDTNL OPTIONS while the Name 
a File Form is displayed, the Additional Options Menu will appear: 

Figure 1-6 
Additional Options Menu-Name a File Form 

13 
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Choosing a Different Directory-If you would like to place this file in a different 
directory than the one you're in, place the cursor at "Choose a different directory/ 
volume" and press DO. A submenu will appear, listing all your directories. 
Choose the one you want. The Name a File Form will reappear. 

If the directory you want is not listed, press ADDTNL OPTIONS again. Another 
submenu will appear, which enables you to choose the next group of directories 
(if another group exists) or to choose a system directory. After you choose the 
directory you want, the Name a File Form will reappear. 

WARNING: Be careful about placing files in system directories. Doing so can 
affect the operating system. 

Changing the File Type-If you need to change your file's type, select "Specify or 
change file type." A submenu will appear, listing four commonly-used file types 
(BASIC, Data, Document, Text) and "Other." Choose the file type you want to 
assign to your file and press DO. If you want to assign your own file type, 
choose "Other" and enter a 3-character file type on the submenu that appears. 

Using an Extended File Name-If you want to specify this file's name and type, as 
well as name the directory and/or volume where it is to be placed, choose "Use ~ 
extended file name." When the submenu appears, enter the specification in the } 
following format: 

VOLUME:[directory]filename.typ 

For example, to place your MEMOS.DOC file on the TABLET volume in the 
JONES directory, you would enter: 

TABLET:[JONES]MEMOS.DOC 

Printing Files 

Choose "Print file" to print your text on the printer. (You must have a printer 
connected to your Professional.) Wait until the printer is not busy to use "Print 
file." When printing begins, the Exit Menu reappears. At this point, your file 
is still available for further editing or for saving. If you want to print and save 
the file, choose "Save file" after choosing "Print file." 

"Print file" is useful for printing the current draft of a document. If you choose ) 
"Resume editing current document" after "Print file," you can look at your 
printout while you continue preparing the text. 

14 



GETTING STARTED I CHAPTER 1 

If you want to prmt your file at a later time, use the "Print" feature from the 
P/OS File Services Menu. Using PRO/Communications, you can also transfer 
files to another computer, and print them on its printer. 

Leaving a Session Without Saving Changes 

If you choose "Leave session without saving changes," you lose the results of 
the work you did during that session. If you were creating a new file, you lose 
everything you entered. If you were working on an existing file, you lose only 
the changes and additions made during that session. 

This is useful when: 

o You are experimenting with PROSE to see how it works, and do not 
want to save what you typed. 

o You want to print a document without saving it. 

o You made a lot of mistakes in your text and want to start again. 

When you choose "Leave session without saving changes," the following question 
appears: 

Do You reallY want to discard edits 
from this session? (YES or NOl 

Type YES and press DO to leave this session without saving changes and return 
to the PROSE Menu. 

Type NO and press DO (or just press DO) to return to the Exit Menu without 
losing your changes. 

Resume Editing Current Document 

Choose "Resume editing current document" to go back to your current editing 
session. This is useful if you change your mind about exiting, or if you are using 
the Exit Menu to print what you have done so far. When you press DO, the 
file you were working on reappears. 

15 







Chapter 2 

PROSE Advanced Features 

After you have used PROSE awhile, you should explore and exercise its full 
potential. You may want to move text around without retyping, or have PROSE 
search for a particular word for you-or you may want to tell PROSE exactly 
where to end each printed page in your document. PROSE enables you to do 
all these things. 

LOCATING TEXT SEGMENTS 

Use the FIND key to locate the first character of a specific text segment. The 
FIND key is useful when you know what text segment you want to change, but 
don't know where it appears in the document. You can also look for repeated 
instances of the same segment. 

Since PROSE moves forward through the text to the next instance of the text 
you typed, you may want to place the cursor at the beginning of the file first 
by using the PREV SCREEN key or the "Top of file" option on the Edit Menu. 

When you press the FIND key, the following prompt appears: 

Enter the text to find and Press DO: 

Type in the word or group of characters you want to find and press DO. If 
PROSE cannot find the text, the following message appears: 

Unable to locate text 

PROSE can only find a text segment that falls on one line. For instance, if it 
is searching for a two-word segment that falls on two lines, the message "Unable 
to locate text" will appear. (Press RESUME to continue editing.) 

19 
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To search for the next instance of the same segment, press DO each time the 
"Enter the text to find and press DO:" prompt appears. You can keep doing 
this until the "Unable to locate text" message appears. 

PROSE ADDITIONAL EDITING FUNCTIONS 

In addition to the PROSE functions performed with the special function keys, 
there are several PROSE editing capabilities available from three PROSE editing 
menus. When entering or editing text with PROSE, you can press the F12, 
F13, or ADDTNL OPTIONS keys to display these menus. The menu will appear 
at the top or the bottom of your screen, depending on the position of the cursor 
at the time that you press the key for that menu. This positioning enables you 
to see your work while you choose from the menu. 

PROSE EDIT MENU 

To display the Additional Options Edit Menu, press F12 while editing a PROSE 
file. If one of the other Additional Options Menus is already displayed, use the 
+- key. The Edit Menu will appear as in Figure 2-1. 

Bottom of' fill! 
Relocate text 
Top of' file 

N,,_ Cotng: OverttJPE Maf31n;: tn ~0 U0rd Vr3c~~~ 
-·--------.---- EGtt ---~,r·--· (t?rso~la:~...::>? --;·-~· -- r~}rtTl2t -----

Figure 2-1 
PROSE Edit Menu 
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The options on the Edit Menu enable you to move the cursor and text segments 
from place to place in your file, as the following sections explain. Press EXIT 
whenever you want to return to editing your PROSE file. 

Bottom of File 

Choose "Bottom of file" to move the cursor to the last line of your file. To use 
it, place the cursor on "Bottom of file" and press DO. 

Relocate Text 

Sometimes you may want to move a text segment to another part of your file, 
or insert the same text in several places in the file. "Relocate text" allows you 
to do these things. To relocate a text segment, use the following steps: 

1. Using the ARROW, PREV SCREEN, NEXT SCREEN, or FIND keys, 
move the cursor to one end of the text you want to relocate. For 
example, 
This is some text to copy, \\t\his is some 
more text, but I do not want to COPY this. 

2. Press REMOVE. 

3. Using the ARROW keys, move the cursor to the other end of the 
text you want to relocate. (If you were relocating a lot of text, you 
could also use the NEXT SCREEN or PREV SCREEN keys.) The text 
segment becomes highlighted in reverse video. 

This is some 

(If you change your mind, press CANCEL to cancel your selection and 
return to the text display.) 

4. Press DO. The highlighted text disappears (and the surrounding text 
fills in). 

5. Using the ARROW, PREV SCREEN, or NEXT SCREEN keys, move 
the cursor to where you want to relocate the segment. For example, 
This is some text• but I do not want to 
COPY this, m\M 

(If you want to restore the text in its original place, leave the cursor 
at the point where you removed the text.) 

6. Press F12. 
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7. Select "Relocate text" and press DO. PROSE moves the text to the 
new location. For example, 
This is some more textr but I do not want 
to COPY this, lhis is some text to copy, 

If the text is not filled properly, use "Fill text." 

8. You can relocate the text as many times as you wish (until you press 
the REMOVE key again) by moving the cursor to the next place 
where you want the text relocated, selecting "Relocate text" from the 
Edit Menu, and pressing DO. 

Top of File 

Use "Top of file" to move the cursor to the top line of the file you are editing. 

PROSE PERSONALIZE MENU 

You display this menu by pressing F13 while in PROSE (or by using the right 
or left ARROW keys from one of the other menus of additional functions). The 
Personalize Menu appears in Figure 2-2: 

Figure 2·2 
PROSE Personalize Menu 
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The options on the Personalize Menu enable you to set defaults that will be 
saved "permanently" (until you change them again). Press EXIT when you want 
to return to your PROSE file. The Menu options are described below. 

Columns 80/132 

When you selec~ "Columns 80/132" and press DO, the width of the screen display 
changes. If the display was set to 80 columns (wide), it changes to 132 columns. 
If the display was set to 132 columns, it changes to 80 columns. Notice that 
when the display changes to 132 columns, the type becomes very condensed. 
This is necessary to fit the 132 columns on the screen. 

Define a Key 

With "Define a key," you can execute up to 250 keystrokes by pressing a single 
key. Eight keys (F17, F18, F19, F20, PF1, PF2, PF3, and PF4) are user­
definable. The keystrokes you specify can include characters, a RETURN, and 
function keys. 

To define a key, do the following: 

1. Move the cursor to the point where you want to begin typing what 
you will assign to a user-definable key. (Since you are in Overtype 
Mode, you may want to use a clear area of the screen.) 

2. 

3. 

4. 

5. 

Press F13. 

Using the ,J. key, move the menu cursor to "Define a key." 

Press DO. 

Type the key sequence that you want to assign to one of the 
definable keys. You might want to define a key to type your name 
and address at the top of a letter, for example: 

Clarence Rutherford 
146 Main Street 
Anytown, U.S.A. 

Use the ARROW keys-not the RETURN key-to move from line to 
line. You can use the RETURN key in a defined sequence, but it 
always moves the next line to the left margin, regardless of the 
cursor's location on the screen. 

Use the <XI key to delete any errors you may make in typing this 
sequence. Your Professional will beep at you if you try to enter more 
than 250 keystrokes into a key definition. 
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6. Press DO when you have finished typing the key sequence. Or, press 
EXIT to cancel the sequence assignment (the text you typed remains 
on the screen). 

7. You will then be prompted to name the character sequence. Type in ~ 
a name for it (maximum of 60 characters and spaces). 

8. Then press the key to which you want the sequence assigned; F17, 
F18, F19, F20, PF1, PF2, PF3, and PF4 are available for this 
purpose. A list on the screen shows which keys are already defined. 
You can also redefine a key. 

Now, whenever you're using PROSE and press the defined key, your 
name and address will appear. 

Note that when you press a defined key it will begin typing its text at the 
current cursor location. If the text extends beyond the right margin, you may 
get unexpected results. 

The best method for learning the advantages of user-definable keys is to experiment 
with them. Here are some possibilities: 

o Using the REMOVE and DO keys, define a key to delete the current l 
line. 

o Using the INSERT HERE and RETURN keys, define a key to open up 
a blank line. 

o Using the underscore (_) and vertical line· <I) characters, define a key 
to draw a box. Or use slashes (/) and backslashes ( \) to create 
triangles and diamonds. 

o Replace one word that appears many times in a document with 
another word (for example, replace "January" with "February"). Once 
you define a key to do this, an otherwise tedious chore becomes a 
simple, fast, precise operation. 

o Define a key to choose a function from the Edit, Personalize, or 
Format Menu. Or define a key to choose several functions at one 
time. 

List Defined Keys 

"List defined keys" displays a list of user-defined keys that have been created 
using the "Define a key" option. Only keys that have been defined are listed. 

24 



r 

ADVANCED FEATURES I CHAPTER 2 

Set Tab Stops 

Choose "Set tab stops" to specify where the cursor will stop when you press 
the TAB key. The tab stops you set in PROSE will not affect other P/OS services. 
With the initial default setting, there is a tab stop at every 8 columns, starting 
at column 9. For example, if the cursor is in a column from 1 to 8, when you 
press the TAB key, the cursor jumps across to column 9. 

When you select "Set tab stops," a ruler appears on your screen. Small diamonds 
above the ruler show the current tab stops. Using the ARROW keys, move the 
cursor across the ruler to where you want a tab; then press SELECT. 

To remove a tab stop, move the cursor to the diamond representing the tab 
stop you want to remove and press SELECT. 

Set Tabs-Additional Options 

While using the tab ruler, you can make some "global" changes to your tab 
settings, or reset them to their former state. To do so, press ADDTNL OPTIONS 
while the tab ruler is displayed. The Tabs Additional Options Menu appears as 
shown in Figure 2-3. 

Figure 2-3 
T~bs Additional Options Menu 
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To use the Tabs Additional Options Menu, place the cursor on "Set tab stops" 
and press DO. Then press ADDTNL OPTIONS to make the Tabs Additional 
Options Menu appear. Following is a description of each option on this menu: 

o "Clear all tabs" removes all tab stops. 

o "Reset tab stops" resets the tab stops to the settings that were in 
effect when you chose "Set tab stops." 

o "Tab stop every 8 columns" sets the tab stops to every 8 columns, 
beginning with column 9. 

Press DO to make the Set Tabs Menu disappear. Press DO again to make the 
tabs ruler disappear and return to your PROSE file. 

Status Line ON/OFF 

By initial default, 22 lines of your text are displayed on the screen. Lines 23 
and 24 are reserved for the status line. If you want to display 24 lines of your 
text and no status line, use the following steps: 

1. Press F13. 

2. Select "Status line ON/OFF" and press DO. 

When you want to restore the status line display, repeat this procedure. 

PROSE FORMAT MENU 

Another menu that provides more advanced PROSE options is the Additional 
Options Menu. To display this menu, you must be in your PROSE file (tab ruler 
not displayed). Press the ADDTNL OPTIONS key. The Format Menu appears 
as shown in Figure 2-4. 

To use these additional options, place the cursor on the item and press DO. 
Press DO again to make the Additional Options Menu disappear. These options 
can be used as follows: 

Center Line 

To use "Center line," place the cursor anywhere on the line you want to center. 
Then choose "Center line" from the Format Menu. When you press DO, PROSE 
centers the line within the margins set for that paragraph. 

26 

~. 
' '...___.., 

---· 



ADVANCED FEATURES I CHAPTER 2 

Figure 2-4 
PROSE Format Menu 

Fill Text 

Use "Fill text" to close up spaces in paragraphs that allow word wrap. 

"Fill text" will not operate on text set to "No wrap" (which is the default setting). 
Use "Margin change/word wrap" (described in the next section) to enable word 
wrap for a paragraph. To fill text in paragraphs that aren't word-wrapped, you 
must use the REMOVE key. 

To use "Fill text": 

1. Move the cursor to the beginning of the paragraph you want to fill 
(use the ARROW, PREV SCREEN, NEXT SCREEN, or FIND keys). 
For example, 

~~is is a samPle of text to be filled. 
When I tYPed this 
I PUt in a lot of 
that 
I do not want now. 

2. Press ADDTNL OPTIONS. 

text in' 
sPaces and carria~e returns 
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3. Choose "Fill text." 

4. Press DO. The paragraph fills. For example, 
This is a saMPle of text to be filled. 
When I tYPed this text int I Put in a lot 
of sPaces and carriage returns that I do 
not want no~·· 

Note that the cursor is at the end of the filled text. 

Margin Change/Word Wrap 

When you begin creating text with PROSE, the left margin is set to column 1 
and the right margin to column 72. Word wrap is off for each paragraph you 
enter. These are the default settings. (A blank line-two carriage returns-marks 
the separation between paragraphs.) 

Word wrap is a very useful PROSE feature that automatically moves any word 
extending beyond the right margin to the next line-without your pressing the 
RETURN key. You should set word wrap OFF when creating tables, columns 
of text, or programs. 

To change margins or the word wrap setting for text, use "Margin change/word , 
wrap." PROSE uses the new settings for the paragraph you selected and for 
subsequent paragraphs (moving forward through the text) until it encounters 
different margin settings that were previously entered and saved. 

To set margins or word wrap, do the following: 

28 

1. Move the cursor to the first line of the text for which you want to 
change margins or word wrap. (Use the ARROW, PREV SCREEN, 
NEXT SCREEN, or FIND keys.) 

If you have not yet typed in the paragraph, before changing the 
setting, press RETURN twice to indicate a new paragraph. 

If you move the cursor to a line within a paragraph, PROSE creates 
the new margin setting starting where the cursor is, but does not 
insert a blank line. 

2. Press ADDTNL OPTIONS. 

3. Select "Margin change/word wrap." 
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Press DO. The status line changes and a ruler appears in your text 
display. For example, 

this is the last line of a paragraph. 
v v 
....•... ·1· ...•... ·2· ...•... ·3· ...•... ·4· ...•... ·5· ....... ·6· ...•... ·7· ... •.... 

This is a new paragraph. I want to turn 1110rd wrap off for this paragraph. 
I also want to change the margins. 

Each dot or number on the ruler represents a column. The v symbols 
mark the left and right margins. 

5. To set a new left margin, move the cursor to the column you want 
and press SELECT. (Press EXIT to cancel your choice and return to 
the text display.) 

6. The cursor then moves to the other v, marking the right margin. 
Move the cursor to the new right margin position and press SELECT. 
You can use SELECT to toggle back and forth between margins until 
you have the settings you want. 

7. If you want to change the word wrap setting, press ADDTNL 
OPTIONS while the margin ruler is displayed. A submenu displaying 
"Not wrapped," and "Word wrapped" appears, with the current state 
indicated by a diamond. Move the cursor to the state you want and 
press DO. You will then be returned to the margin ruler. 

8. Press DO when you are ready to leave the "Margin change/word 
wrap" display. 

If you change the margins on wrapped text, PROSE rewraps the 
text to fit within the new margins. It will continue rewrapping the 
text until it encounters margin settings that were previously entered 
and saved. 

To find out the word wrap and margin settings for any paragraph, move the 
cursor to it and look at the status line. 

New text can be inserted into existing text that contains different margin settings. 
For instance, you might want to set off a note with narrower margins than the 
body of the surrounding text. This is accomplished by doing the following: 

1. Position the cursor at the point where you want to insert the note. 

2. Press INSERT HERE and then RETURN to create a blank line for the 
start of a new paragraph. 
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3. Press ADDNTL OPTIONS and select "Margin change/word wrap." 

4. The margin ruler will appear on the screen. Set the margins to the 
new width. 

5. Press DO once and insert your text. 

6. When you have finished entering your text, press RETURN to leave a 
blank line, ending the paragraph. 

7. Press DO to complete the operation. 

8. If necessary, go back and adjust the margins of the text at the 
cursor's current location. 

When you exit the session, PROSE asks you whether you want to save these 
word wrap and margin settings. See "Saving Text" in Chapter 1 if you need 
more information. 

Numbered and Bulleted Lists 

To format a numbered or bulleted list, follow these steps: 

.:--_-

1. Make sure that the word wrap setting is set to "Not wrapped." l 
2. Set the left margin at the column against which the text portion of 

the list should align. 

3. Enter your text using the conventions described in the previous 
section. 

4. Using the ARROW keys, place numbers or bullets for outside the left 
margin next to each list item. 

Now, if you change the margins, the list will remain intact, as well as the 
numbers and/or bullets. However, numbered and bulleted lists can be destroyed 
by changing the format from "not wrapped" to "wrapped." 

Page Break 

A page break marks where your text will begin a new page. With some printers, 
you can specify the number of lines for each page (see your Hard Disk System 
User's Guide). If you want to insert special page breaks using "Page break," 
set your printer's top and bottom margins and page length to the correct values 
before printing your file. 

30 
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To insert a page break, do the following: 

1. Use the ARROW, PREV SCREEN, NEXT SCREEN, or FIND keys to 
move the cursor to the place you want the new page to begin. For 
example, 

This is some text. I have written several pages of text--this is only 
part of what I have written--and I want to 1nsert a page break so that 
the printer w1ll pr1nt my text as I request. For example, I need to use 
page breaks to make sure that a table is printed entirely on one page. 

2. Now select "Page break" from the PROSE Format Menu. (Press 
EXIT if you decide to cancel the procedure and return to your 
PROSE file.) 

3. Press DO. A double line appears, showing where the text will break. 
For example, 

This IS some text. I have written several pages of text--this IS only 
part of what I have written--and I want to 1nsert a oage break so that 

the printer w1ll pr1nt my text as I request. For example, I need to use 
page breaks to make sure that a table is printed entirely on one page. 

Set page breaks in your text after all edits have been made. Otherwise, changes 
to the text can affect your page breaks. 

When printing files, P/OS causes the printer to jump (form feed) to the next 
page when it reads a page break. The double line that appears in your screen 
display is not printed on the paper copy. PROSE considers a page break as 
the start of a new paragraph. 

While editing your PROSE file, if you decide to delete an existing page break, 
place the cursor anywhere on the page break double lines and press <KJ. 
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Glossary 

application (or application program) 
A computer program that meets some specific user need. PROSE is a 
text editing application. 

auxiliary keypad 

cursor 

default· 

The set of keys on the far right of the Professional keyboard. 

The blinking rectangle or underscore on the monitor screen that shows 
where the next typed character will appear. 

Information that the Professional assumes unless you explicitly provide 
or change it. 

directory 

EDT 

A group of files stored on a disk or diskette. A directory can include all 
or only some of the files on the volume. When you initialize a volume, 
P/OS creates a directory for you called USERFILES. You can create 
your own directories, if you wish. 

Digital's interactive text editor, which has different features and methods 
than PROSE. 

editing keypad 
The set of gray keys between the main keyboard and the auxiliary 
keypad. Like the keys of the auxiliary keypad, these keys can function 
differently for different applications. 
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editor 

file 

An application program that allows you to create and modify text files. 

A collection of information treated as a unit. A file may contain a memo, 
a program, or other information. Its purpose is analogous to that of a 
conventional office file. 

function key 

install 

A key on the Professional keyboard that, when pressed, instructs P/OS 
or an application to do something specific. The HELP, DO, INTERRUPT, 
HOLD SCREEN, PRINT SCREEN, and ARROW keys perform the same 
function all the time. Other function keys, such as PREV SCREEN, 
RESUME, CANCEL, EXIT, FS, F17, and so on, have functions that 
depend on the application currently in use. 

To copy an application such as PROSE from an application diskette onto 
the disk, integrating that application into the menu system. 

keyboard 
The component that enables you to communicate with the Professional. 
It contains the main keyboard (similar to a typewriter keyboard), a row ~ 
of function keys at the top, the editing keypad, and the auxiliary keypad. , ·.' 

menu 
A list of available services or functions which appears on the Professional 
screen. 

monitor 
The part of the Professional that contains the video display screen. 

Overtype Mode 

P/OS 

The way PROSE handles what you type in a file unless you use the 
INSERT HERE key. In Overtype Mode, PROSE replaces existing text 
when you type over it. 

The Professional's operating system. The operating system manages the 
computer. 

PRO/Communications 

36 

A P/OS application that enables you to use your Professional to com­
municate with DIGITAL PDP-11 and VAX host computers. With PRO/ 
Communications, you can transfer files to and from the host and use 
your Professional as if it were a terminal on the host computer. 
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program 

prompt 

A sequence of instructions used by a computer to perform specific op­
erations. PROSE can be used to write programs. 

A screen display request for you to type in certain information. 

software 
The collection of programs and information associated with a computer. 
Software is to a computer as your thoughts are to your body: software 
is intangible (consisting of electrical signals when in operation), but it 
makes the computer work. 

system unit 

volume 

The part of your Professional that contains the diskette drives, disk, 
option modules, power supply, and the computer itself. The system unit 
is the central component of the Professional. 

A generic name for a magnetic file-storage medium, such as a disk or 
diskette. 

word wrap 
The feature that moves a word to the beginning of the next line if the 
word extends beyond the right margin of the current line when you type 
it. PROSE allows you to activate and deactivate word wrap by setting 
it ON or OFF. 

write-protect tab 
An adhesive tab that can be applied to the write-protect notch on a 
diskette to prevent users from changing or deleting any file on that 
diskette. It is necessary to remove the tab to create, change, or delete 
any files on the write-protected diskette. 
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HELP key, 3 

INSERT HERE key, 9 
Insert Mode, 9 
Inserting a page break, 30 
Inserting text, 9 
Installing PROSE, 3 

Keys 
see Function keys 

Leaving a session, 15 
List formatting, 30 
Listing defined keys, 24 
Locating text, 19, 21 

Margin change/word wrap, 28 
Margins, 7 

changing, 28 
Moving text, 21 

Name a File Form, 12 
Naming files, 13 
Numbered lists, 30 
Numbered, bulleted lists, 30 

Overtype Mode, 7 
Overview of PROSE, 3 

Page break, 30 
Personalize Menu, 22 
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Printing files, 14 
PRO/Communications, 12 
PROSE Menu, 5 

Relocating text, 21 
REMOVE key, 10 
Removing text, 10 
Resume editing, 15 
RESUME key, 7, 19 
RETURN key, 6, 10, 24, 28 

Saving files, 11 
Saving margin/word wrap settings, 30 
SELECT key, 25 
Set tab stops, 25 
Status line, 7 

displaying, 26 

TAB key, 7, 25 
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